
Print command (File menu)
Use this command to print a document.    This command presents a Print dialog box, where you may 
specify the range of pages to be printed, the number of copies, the destination printer, and other printer 
setup options.

Shortcuts
Toolbar:
Keys: CTRL+P



Print dialog box
The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the printer and 
printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to produce.



Print Progress Dialog
The Printing dialog box is shown during the time that APRCalc is sending output to the printer.    The page
number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)
Use this command to display the active document as it would appear when printed.    When you choose 
this command, the main window will be replaced with a print preview window in which one or two pages 
will be displayed in their printed format.    The print preview toolbar offers you options to view either one or
two pages at a time; move back and forth through the document; zoom in and out of pages; and initiate a 
print job.



Print Preview toolbar
The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)
Use this command to select a printer and a printer connection.    This command presents a Print Setup 
dialog box, where you specify the printer and its connection.



Print Setup dialog box
The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific Printer option 
and select one of the current installed printers shown in the box.    You install printers and configure 
ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to the type of 
printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Select Printing Options dialog box
This dialog to allow you to select options and input data for the printout.    The items in this dialog box are 
described below.

Print Custom Title

By checking this checkbox, you can enter text into the "Custom Title" edit field (described below), and it 
will be printed at the beginning of the printout.    This custom title text can be used to customize printouts; 
for example, a person's name could be entered here.    If this checkbox is unchecked, the custom title text 
(if any) will not be printed.

Print Notes

By checking this checkbox, the Notes entered into this loan scenario will be printed at the end of the 
printout.    If this checkbox is unchecked, the Notes (if any) will not be printed.

Custom Text

You can enter text into the "Custom Title" edit field (described below), and it will be printed at the 
beginning of the printout, if the "Print Custom Title" checkbox is checked.    This custom title text can be 
used to customize printouts; for example, a person's name could be entered here.    If that checkbox is 
unchecked, the custom title text (if any) will not be printed; also, you cannot edit text in this control.

Related Topics:

Add A Note



APRCalc 2.2 Help - Contents
APRCalc 2.2 quickly figures APR payments and amortizations for such things as 
mortgage loans, car loans, and student loans.

An overview of this program, and a brief description of 
features new at this revision.
Step-by-step instructions on all procedures.

Descriptions of all menu and toolbar actions.

Details of how this program was developed, plans for 
future revisions, and history of past revisions.
Information about shareware, the license agreement, and 
how to register your copy of APRCalc.



Introduction Topics
Please select one of the following topics:

Overview
New Features



How To Topics
Please select one of the following topics:

Enter Values
Setup Rates for ARM
Choose the Payment Period
Select the First PaymentDate
Calculate the Desired Value
Amortize Payments
Display Annual Subtotals
Find Subtotals for Selected Payments

Select Payments
Enter Prepayments to Principal
Find Prepayments for Proposed Term
Clear All Prepayments

Add A Note
Create an Icon for a File in Program Manager
Create an Icon for a File in Program Manager Using Drag and Drop
Open a File via Drag-and-Drop

Enter a Password for a Scenario

Un-install APRCalc



Menu Commands Topics
Please select one of the following topics:

File menu
Edit menu
View menu
Tools menu
Window menu
Help menu



Technical Notes Topics
Please select one of the following topics:

Implementation Notes
The APR Payment Equation
Comparing APRCalc with Actual Payments
Planned Enhancements
Revision History



Registration Topics
Please select one of the following topics:

What You Get By Registering
Registering APRCalc
License Agreement and Warranty Disclaimer
Definition of Shareware



Overview
APRCalc is a small and simple payment calculator that allows the user to investigate various loan 
scenarios very quickly (it also has been very useful as a learning tool for me).    The program is designed 
for mortgage loans, car loans, student loans, etc., but is certainly not limited to those examples.

The four variables in an APR loan are the Amount Financed, the Term, the APR Rate, and the Payment; 
setting any three of these determines the fourth.    Typically, you would enter a value for each of the three 
known variables, and then click the button for the variable to be calculated.    After all variables are 
entered, the user input is checked for validity (for example, the term of the loan must be a reasonable 
counting number).

Amortizations are done very quickly and in the background (so it does not "hog" your system).    Total 
interest and principal can be displayed on a calendar year basis, or you can select whichever payments 
you like and APRCalc can display the totals for only those payments.

The effect of making prepayments to principal can be investigated by selecting whichever payments you 
wish in the amortization window, and setting a prepayment dollar amount for them; APRCalc will 
reamortize the loan using the new prepayments.    Conversely, you can even figure out what the 
prepayments would have to be (on the payments you select) to reduce the term to a specified number of 
payments!    The amount of interest the prepayments saved you over the life of the loan is automatically 
displayed.    APRCalc even makes it easy to select payments in several common patterns via the 
Selected... pushbutton.

Adjustable rate mortgages (ARMs) can be analyzed, and you can not only enter various annual and 
lifetime caps, but APRCalc will calculate each payment's interest rate using a worst case, best case, or 
"average" scenario!

Loan scenarios can be saved in individual files through the standard "File, Save..." menu option.    
("*.APR" files that were created with previous versions of APRCalc can, of course, be opened and re-
saved using this version.)    APRCalc supports drag-and-drop from the File Manager, and scenario files 
can be opened by simply double-clicking on any *.APR file in the File Manager.

Several options are included, such as calculating the breakeven date for a loan's discount points, the 
ability to make APRCalc always stay on top, aligning MDI child windows, exporting to ASCII, and 
choosing the period (weeks/biweeks/months/quarters/years) of the payments.    The standard Windows 
"Cut/Copy/Paste" functionality is supported.    You can even set a password on scenarios for improved 
privacy.

APRCalc is distributed as Shareware (See: Registering), and an installation program is provided.    The 
program does not read or modify any system profiles without asking you first (it creates its own profile in 
the WINDOWS directory, called APRCALC.INI).    It does however, add an entry to the Registration 
database.



New Features
Here are the new features at Revision 2.2 of APRCalc:

1. The frame of the main window now sizes correctly for large fonts.

2. The drop-down calendar control is a little more attractive, and now
spaces better when large fonts are being used.

3. The bitmapped pushbuttons are now sized based on the font set in
use for better appearance.

4. The printouts are now cleaner looking and more attractive.    Also 
the duplicate average payment field were removed.

5. The hardcopy label for printouts (Prepared for x by y.) can now be 
a maximum of 120 characters (instead of 80).

Related Topics:

Planned Enhancements
Revision History



Entering Values
The values for any of the four loan variables may be entered in three ways:

1. Simply click on the edit field and type the values in.    If you enter an illegal 
value, APRCalc will tell you so when you try to amortize the loan.

2. Use the drop-down box to the right of the edit field to select one of the previous 
values entered/calculated for this field.

3. Use the spinbuttons to the left of the edit field to increment or decrement the 
value of the field by a pre-set amount.

Also note that you can optionally enter a first payment date; this date is used by the amortization schedule
and other time-related calculations.    If you do not enter a first payment date, APRCalc selects a 
reasonable one for you.

Related Topics:

Choosing the Payment Period
Calculating the Desired Value
Selecting the First Payment Date



Setting Up Rates for an ARM (Adjustable Rate Mortgage)
Rates for Adjustable Rate Mortgages can be setup by clicking the button next to the "Rate" button. 

The "Initial Rate" is the base rate that is set for the beginning of the ARM.    This rate will be applied as a 
flat rate for the number of payments entered in the "first payments" field.    The interest rate will then float 
(usually it is tied to a well-known interest-rate), but cannot change (in either direction) in any one year by 
more than the amount entered in the "Annual Cap" field.    In no case can the rate change by more than 
the "Lifetime Cap" over the entire period of the loan.

Three different scenarios can be selected by the user to determine how the interest rate will fluctuate over
time (note that the scenarios' names are from the borrower's point of view):

Worst Case The interest rate rises as much as it can every year (within 
the bounds of the annual and lifetime caps).    You will have 
the highest possible payments under this scenario.

Best Case The interest rate falls as much as it can every year (within 
the bounds of the annual and lifetime caps).    You will have 
the lowest possible payments under this scenario.

Average 
Case

The interest rate will randomly rise and fall every year after 
the initial payment    (within the bounds of the annual and 
lifetime caps).    The rates are calculated to mimic the 
business cycle, and so will rise and fall over time in roughly 
a "sine-wave" pattern.

 
Usually, you will be most prudent to select the Worst Case scenario, although the Average Case scenario 
may more closely emulate the actual ups and downs of the variable interest of the life of the loan.    (The 
Best Case scenario, while mathematically accurate, should be used only for amusement purposes!)

Please be aware that the Average Case scenario, since it relies on rolling averages of random numbers, 
will calculate interest rates that will be different each time the loan is amortized.

Setting up ARM variables automatically disables the "Rate" field on the main screen - the previously 
entered flat interest rate value is still visible there (for your reference); if no flat rate was entered, the Initial
Rate entered here will be copied to it.

To change back to the flat interest rate calculation model, simply click the "Revert to Flat Interest Rate" 
button.    The variable rate parameters will be saved with the loan scenario regardless of how the rates are
calculated when the scenario is saved.

Related Topics:

Entering Values



Choosing the Payment Period
The number of payments per year can be selected by clicking the button next to the term button.    A 
dialog box will appear - clicking any of the radio buttons will immediately select that payment period 
(Weekly, BiWeekly, Monthly, Quarterly, or Yearly) and close the dialog.

Note that the numerical value in the Term field will not automatically change when you change the Term 
type in this manner - so, if you are changing from Months to Quarters (for example), you must remember 
to divide the number in the Term field by three (since there are three months in a quarter).

Related Topics:

Enter Values
Setup Rates for ARM



Selecting the First Payment Date
To select the first payment date using the drop-down calendar control, first click the control.    A one-month
calendar page will drop down.    The month or year can be paged forward or backward by first selecting 
either the month or year text (a border will appear around it to indicate it is selected), and then clicking 
either of the arrow controls.    To select a day, simply click its number.



Calculating The Desired Value
Any of the four variables in the loan (the Payment, the Amount Financed, the Term, and the Interest Rate)
can be calculated by entering values for the other three variables, and then clicking the appropriate 
button.

Each time one of the buttons is clicked in this manner, the loan is reamortized and the amortization 
window is cleared and then refilled.

Note that if no first payment date has been entered, a default value is used.

Related Topics:

Comparisons to Actual Payments
Enter Values
Setup Rates for ARM
Choose the Payment Period



Amortizing Payments
When money is loaned, two debts must be repaid by the borrower: the Principal and the Interest.    Each 
payment made by the borrower is applied to both the Interest and the Principal.    In a home mortgage 
loan, almost all of the early payments go to pay the Interest debt, with a very small portion being applied 
to Principal (hence the phrase young doorknob owners).    As the loan is paid off, an ever-increasing 
portion of each payment is applied to the Principal; the last few payments are almost entirely applied to 
the Principal.

APRCalc will display the amortization of the loan in the amortization window when you click any of the 
buttons that figure the payment.      The fields in the amortization window are:

Pmt# The payment number.
Pmt Date The date of the payment.
Prepmt The prepayment (if any) paid after the payment is made.
Principal The amount of the payment applied to principal.
Interest The amount of the payment that is interest.
Payment The total amount of the payment.
Balance The outstanding principal still remaining after the payment is 

made.
Rate The interest rate for this payment.

The amortization schedule may be printed using the "File, Print..." menu item.    A line of text can be 
added to the beginning of the printout to customize it; currently it is preloaded with the phrase 
"Amortization Schedule - Prepared for X by Y." to make it easy to insert names.

Note that the amortization window can be scrolled either by using the mouse on the scrollbar, or by the 
keyboard's cursor keys.    The "Home" and "End" keys are also supported.    There are also button 
immediately above and below the scrollbar that scroll the window to the top and bottom.

Amortization schedules are calculated in the background, so even for very large terms on very slow 
computers (which could take as long as two minutes), APRCalc will not "hog" the system - other 
applications will continue to run, and you may switch to other programs (for instance, via "Alt-Tab") at will. 
Also, the amortization calculations are begun as soon as you click any of the buttons that figure a 
payment.

Related Topics:

Printing an Amortization
Exporting an Amortization
Display Annual Subtotals
Find Subtotals for Selected Payments
Select Payments for Prepayments
Enter Prepayments to Principal



Displaying Annual Subtotals
The total amounts of principal and interest paid during each calendar year can be displayed in the 
amortization window by clicking the "Annual Subtotals" checkbox.    Note that after you check the 
checkbox, the subtotals will not be displayed until the next time the amortization is calculated.    The 
checkbox is of course disabled if Annual payments are being made.

The total amount of Principal for each year includes any prepayments made during that year.

Related Topics:

Find Subtotals for Selected Payments
Select Payments



Finding Subtotals for Selected Payments
You can find the total amount of principal and interest paid during any payments you select in one of two 
ways:

To find the totals up to and 
including a given payment:

Select only the last payment you want to 
include in the group, then click the "Prepaid" 
button.    The totals for all payments up to and 
including this one will be displayed in the 
"Totals to Date" area.

To find the totals for a 
specific group of payments:

Select the payments you want to be totals, 
then click the "Prepaid" button.    The totals for
all selected payments will be displayed in the 
"Totals for Selected Payments" area.
 

You might want to use this feature to find out how much interest you will pay during, say, the first five 
years of the loan.

Please be aware that the total interest paid during the entire life of the loan will always be displayed after 
the last payment, at the end of the amortization window, so there is no need to use the above methods to 
find the total interest paid in that case.

Related Topics:

Select Payments
Display Annual Subtotals



Selecting Payments
The "Selected..." button is used to easily select various combinations of payments in the amortization 
window.    Although you can use the mouse to select, for example, every 6th payment in a 360 month 
amortization, that can be very tedious.    The "Selected..." button makes it much easier, and also displays 
the number of payments currently selected.

The options in the Select dialog box are:

All Selects all payments.

None De-selects all payments.

Prepayments Selects payments that have prepayments.

First Selects the first "n" payments, where "n" is the
value you enter into the "payments" field.

Every Selects every "n"th payment, starting at the 
first, where "n" is the value you enter into the 
"payments" field.

The "Selected..." dialog box selects payments in an "additive" way (unless you select "None", of course).   
For example, to select the first 12 payments, and then the last payment of each year after that (assuming 
monthly payments), you would use the "Selected..." dialog twice, and the results would add together to 
give you the desired result.

While the "Selected..." button is very convenient, please note that the amortization window itself supports 
multiple selections with the mouse (or keyboard arrow controls) in combination with holding down the 
Shift and/or Control keys in the standard Windows manner.    Also note that multiple payments can be 
selected by simply clicking a payment, holding down the mouse button, and moving it to below or above 
the amortization window.

Some entries in the amortization window cannot be selected (even if you click the mouse directly on 
them!) because they are not payments.    These entries are the annual subtotals (if enabled), any blank 
lines, and the summary lines at the end of the amortization.

Note that the "Selected..." button is disabled whenever the loan is not fully amortized; this is to prevent 
you from adding or changing prepayments while the amortization is in progress.

Related Topics:

Find Subtotals for Selected Payments
Enter Prepayments to Principal



Entering Prepayments to Principal
When one or more items in the amortization window are selected (which is indicated by their being 
displayed in reverse video), the "Prepaid..." button is enabled.    This button displays the number of 
payments in the current amortization that have prepayments, and is used to access the Prepayment 
dialog box.    The "Prepaid..." button is disabled whenever the loan is not fully amortized; this is to prevent 
you from adding or changing prepayments while the amortization is in progress.    It will also be disabled 
whenever there are no payments selected in the amortization window.

The controls in the Prepayments dialog box are described below.

The Flat Amount combobox

The Flat Amount combobox allows you to view and edit the prepayments for the selected payments in the
amortization window (not all the payments, and not necessarily the ones with prepayments, just the 
selected payments!).    If all the selected payments have the same prepayment amount, that amount will 
be displayed in this combobox when the dialog box is first entered.    If the selected payments have more 
than one prepayment value among them, the initially visible part of this combobox will be empty when the 
dialog box is first entered.

In either case, the "drop-down" portion of this combobox will contain all the values for the selected 
payments.    For example, say there are five selected payments: if two of the selected payments have a 
prepayment of $100, and one has a prepayment of    $500, and two have no prepayment, the drop-down 
portion of the combobox will contain one entry of $100 and one entry of $500.    (Also, the initially visible 
part of this combobox will be empty).

The Reduce To edit field

The Reduce To "n" Payments edit field allows you to answer the question, "How much would the 
prepayments (for the selected payments) have to be to make the term be "n" payments long?"

For example, say a loan of $140,000, at 7%, over 360 months, has a payment of $931.43.    How much in 
prepayments would we have to make every three months to reduce the term to 15 years (180 months)?    
First, select every third payment using the "Selected..." button.    Next, click the "Prepaid..." button, and 
enter "180" into the "Reduce To" edit field.

Now, APRCalc will iteratively find a solution to this question by "guessing" a value for the prepayment for 
the selected payments, amortizing the loan, and seeing what the resulting number of payments is.    (This 
process may take a few minutes).    After four iterations, APRCalc reports that the prepayment required for
our scenario is $976.29.

When the iterations are complete, you are asked if you want to apply these prepayments or not; if you 
answer "No", APRCalc will revert the loan scenario to its previous state.    APRCalc will do the same if you
cancel the iterations at any time.

It is almost guaranteed that APRCalc will find a solution for any non-trivial scenario posed to it.    There 
may be occasions, however, especially involving variable rate loans (such as ARMs), where APRCalc 
cannot find a solution.    In those cases, APRCalc will stop after 100 iterations, or when successive 
prepayment "guesses" differ by less than $0.01, or when you cancel it.

The Clear All Prepayments button



The "Clear All Prepayments" button is provided as an easy way to erase the prepayments for all 
payments in the amortization.    It does not take effect, however, until the "Ok" button is clicked; if the 
"Cancel" button is clicked, the prepayments are not all cleared.    You can click the "Clear All 
Prepayments" button, and then enter a prepayment amount for the select payments, and both actions will 
take place when you click the "Ok" button.

The Totals Area

The total principal and interest for selected payments are display in the Total Area.    See Related Topics 
below.

Related Topics:

Select Payments for Prepayments
Find Prepayments for Proposed Term
Clear All Prepayments
Find Subtotals for Selected Payments



Finding Prepayments for Proposed Term
See the discussion of the "Reduce To" edit field in the Enter Prepayments to Principal topic.

Related Topics:

Select Payments for Prepayments
Clear All Prepayments
Enter Prepayments to Principal



Clearing All Prepayments
See the discussion of the "Clear All Prepayments" button in the Enter Prepayments to Principal topic.

Related Topics:

Select Payments for Prepayments
Find Prepayments for Proposed Term
Enter Prepayments to Principal



Prepayments Calculation Status Dialog Box
The Prepayment Calculation Status box appears while APRCalc is iteratively finding the prepayments 
required to make the term a specified number of payments.    You cannot enter data into APRCalc while 
these calculations are going on.

The items in this dialog box are described below.

Target Payment Count

This displays the number of payments you requested that the Term be reduced to.

Iteration Number

The iteration number displays the number of times APRCalc has amortized the loan, using different 
prepayment values each time, in its attempt to reduce the Term to the number of payments you 
requested.    If no solution is found, APRCalc will cancel the calculations after 100 iterations, or when the 
prepayment "guesses" differ by less than $0.01 in successive iterations.

Estimated Prepayment

The current "guess" that APRCalc is using for the prepayment amount for the selected payments is 
displayed as the Estimated Prepayment.

Percent Completed

APRCalc can estimate its current progress based on the number of payments you requested compared to
the actual number of payments it calculated during the most recent iteration.    This number is only an 
approximation, and usually will increase in "fits and starts".

Cancel Button

You may abort the iterations at any time by clicking the "Cancel" button, and APRCalc will stop iterating 
and return your loan scenario to exactly the way it was before.

Related Topics:

Select Payments for Prepayments
Find Prepayments for Proposed Term
Clear All Prepayments
Enter Prepayments to Principal



Adding a Note to a Loan Scenario
You may add a Note to each loan scenario, which will be saved along with the loan information in its 
"*.APR" file.    The Note may be up to 4096 characters long.    When a loan scenario has a Note, the Note 
pushbutton will display a star (that is "*Note").

Related Topics:

Saving a File



Creating an Icon for a File in Program Manager
APRCalc files can be setup as icons in Program Manager (you could even give them their own group).      
There are two ways to do this:

1
.

The easy way (See: Creating an Icon for a File in Program 
Manager Using Drag and Drop).

2
.

The hard way (see below).

The Hard Way

In the Program Manager, click on the title bar of the group you want to place the file in (this will ensure it is
selected).

Select "File, New..." from the menu.    The next window will ask if you want a new group or an item (they 
mean icon).    Select "Program Item".

The next window ("Properties") is the hard part.    If you are comfortable using the "Browse..." screen, do 
so, as it is the easiest way.      Otherwise, fill in the four fields as follows:

Description Type in what you want the icons title to be.    For 
example, "My Student Loan".

Command Line Type in the full pathname of the APR file. For example, 
"C:\APRCALC\JOE_CAR.APR".    (If that does not 
work, APRCalc not associated in WIN.INI, so try 
including the pathname of the APRCalc program: "C:\
APRCALC\APRCALC.EXE    C:\APRCALC\
JOE_CAR.APR".)

Working Directory Enter the full pathname of the directory that contains 
APRCALC.EXE.

ShortCut Key You can safely leave blank.

You can also change the icon; several icons have been included for customization.    Also, if you like an 
icon that is part of another program, you can use the Browse... button to select the EXE file for that 
program, and probably find your icon.

Related Topics:

Creating an Icon for a File in Program Manager Using Drag and Drop



Creating an Icon for a File in Program Manager Using Drag and 
Drop
You can create an icon for a file in Program Manager by dragging an .APR file from the File Manager to a 
group in the Program Manager.    Open both the Program Manager and the File Manager.    Put the mouse
over an ".APR" file in the Program Manager.    Click the mouse and hold it down, dragging the file to any 
group in the Program Manager.    Then release the mouse button.

Related Topics:

Creating an Icon for a File in Program Manager
Opening a File via Drag-and-Drop



Opening a File via Drag and Drop
You can also open files by dragging them from the File Manager to the APRCalc window.    All you have to
do is have the File Manager and APRCalc both open on the screen.    Put the mouse over top of an .APR 
file in the Program Manager.    Click the mouse and hold it down, dragging the file to the APRCalc window 
- then release the mouse button.    Note that this will work even if the APRCalc program is minimized on 
the screen.

Related Topics:

Creating an Icon for a File in Program Manager Using Drag and Drop
Opening a File
Opening the Most Recently Used Files



Setting a Password on a Scenario
Scenarios can be password protected for improved privacy.    To enter, change, or delete a password for a
scenario, simply click the key button that appears to the right of the Note... pushbutton.

To enter a password, type in the old password for this scenario (if there is one), and then enter the new 
password in each of the two New Password boxes (you are asked to enter it twice to be sure you type it in
correctly).

To delete a password, type in the old password, and enter nothing in the two New Password boxes.

Note that changes to the password are not saved until the scenario itself is saved, using (for example), 
the File, Save... menu item.

Related Topics:

Entering a Password for a Scenario



Entering a Password for a Scenario
If a scenario has been previously protected with a password, you will be prompted to enter that password 
then next time you attempt to open the scenario.    To access the scenario, enter the correct password in 
the Password box and click the Ok button.    To abandon the attempt to access the scenario, click the 
Cancel button.

Related Topics:

Setting a Password for a Scenario



Un-Installing APRCalc
To "uninstall" the program, simply erase the following files (depending on how you got APRCalc, some of 
these files may not exist on your disk):

APRCALC.EXE The executable run file.
WINDOWS\APRCALC.INI The initialization file.
ORDER.TXT The order form for this product.
APRCALC.HLP This Help file.
README.TXT Information file.
REGISTRD.ID Registered user name file.
WINDOWS\INSTALL.EXE Installation program.

Also, APRCalc automatically adds an entry for itself in the Registration Database.    If you know what this 
is, and are comfortable editing it, you may do so to remove the APRCalc entry; otherwise, it would be 
wiser to leave it alone, as it is possible to seriously damage your Windows software settings by fiddling 
with it.



File menu commands
The File menu offers the following commands:

New Creates a new scenario.
Open Opens an existing scenario.
Close Closes an opened scenario.
Save Saves an opened scenario using the same file name.
Save As Saves an opened scenario to a specified file name.
Save All Saves all opened scenarios to your disk.
Delete Deletes any APR file from your disk.
Print Prints a scenario.
Print Preview Displays the scenario on the screen as it would appear printed.
Print Setup Selects a printer and printer connection.
Export Exports the scenario to a tab-delimited ASCII text file.
Exit Exits APRCalc.

Edit menu commands
The Edit menu offers the following commands:

Cut Deletes data from the scenario and moves it to the clipboard.
Copy Copies data from the scenario to the clipboard.
Paste Pastes data from the clipboard into the scenario.



View menu commands
The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Always On Top Makes the application the "topmost" window.

Tools menu commands
The Tools menu offers the following commands:

Discount Points Calculates discount point breakeven date.

Window menu commands
The Window menu offers the following commands, which enable you to arrange multiple views of multiple
scenarios in the application window:

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Close All Closes all open windows.
Align To Corner Aligns the active window to the top-left corner of the frame window.
Window 1, 2, ... Goes to specified window.

Help menu commands
The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.
Searching Allows you to search for help on a particular subject.
Using Provides help on using Windows help.
About Displays the version number of this application.

New command (File menu)
Use this command to create a new scenario in APRCalc.

You can open an existing scenario with the Open command.

Shortcuts
Toolbar:
Keys: CTRL+N



Open command (File menu)
Use this command to open an existing scenario in a new window.    You can open multiple scenarios at 
once.    Use the Window menu to switch among the multiple open scenarios.    See Window 1, 2, ... 
command.

You can create new scenarios with the New command.

Shortcuts
Toolbar:
Keys: CTRL+O



File Open dialog box
The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open: you will normally open only APR-type files.

Drives
Select the drive in which APRCalc stores the file that you want to open. 

Directories
Select the directory in which APRCalc stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)
Use this command to close all windows containing the active scenario.    APRCalc suggests that you save 
changes to your scenario before you close it.    If you close a scenario without saving, you lose all 
changes made since the last time you saved it.    Before closing an untitled scenario, APRCalc displays 
the Save As dialog box and suggests that you name and save the scenario.

You can also close a scenario by using the Close icon on the scenario's window, as shown below:



Save command (File menu)
Use this command to save the active scenario to its current name and directory.    When you save a 
scenario for the first time, APRCalc displays the Save As dialog box so you can name your scenario.    If 
you want to change the name and directory of an existing scenario before you save it, choose the Save 
As command.

Shortcuts
Toolbar:
Keys: CTRL+S



Save As command (File menu)
Use this command to save and name the active scenario.    APRCalc displays the Save As dialog box so 
you can name your scenario.    

To save a scenario with its existing name and directory, use the Save command.



File Save As dialog box
The following options allow you to specify the name and location of the file you are about to save:

File Name
Type a new filename to save a scenario with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    APRCalc adds the "APR" extension if you do 
not provide one, otherwise it will append the extension you specify in the Save File As Type box.    You
should always use the "APR" extension.

Drives
Select the drive in which you want to store the scenario.

Directories
Select the directory in which you want to store the scenario.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Save All command (File menu)
Use this command to save all scenarios.    If any of the scenarios currently open have not yet been 
named, APRCalc displays the Save As dialog box so you can name each scenario.

To save a scenario with its existing name and directory, use the Save command.



Delete command (File menu)
Use this command to erase any APR file from your disk.    When you access this command, APRCalc 
displays the Delete dialog box so you can select the file you wish to delete.    You are warned that deleting
the file will permanently remove it from the disk (however, it potentially can be un-erased like any other file
by using an appropriate file-management utility).



File Delete dialog box
The following options allow you to specify the name and location of the file you are about to delete:

File Name
Type a filename to delete an APR file.    A filename can contain up to eight characters and an 
extension of up to three characters.    APRCalc adds the "APR" extension if you do not provide one, 
otherwise it will append the extension you specify in the Type box.    You should always use the "APR"
extension.

Drives
Select the drive from which you want to delete the scenario.

Directories
Select the directory from which you want to delete the scenario.



1, 2, 3, 4 command (File menu)
Use the numbers and filenames listed at the bottom of the File menu to open the last four scenarios you 
closed.    Choose the number that corresponds with the scenario you want to open.



Export command (File menu)
An amortization can be quickly exported to a ASCII text file, which can then be read by a spreadsheet, 
database, or word processor.    The export file is tab-delimited, and by default has a ".TXT" extension.    
No dollar signs, spaces, or commas are exported to the file.

To export an amortization, select "File, Export..." from the menu.    You will be prompted for the filename to
export to.    If the filename you enter already exists, you will be asked if you want to overwrite it.

Shortcuts
Toolbar:

Related Topics:

Amortizing Payments



Exit command (File menu)
Use this command to end your APRCalc session.    You can also use the Close command on the 
application Control menu.    APRCalc prompts you to save scenarios with unsaved changes.

Shortcuts
Toolbar:
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Cut command (Edit menu)
Use this command to remove the currently selected data from the scenario and put it on the clipboard.    
This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts
Toolbar:
Keys: CTRL+X



Copy command (Edit menu)
Use this command to copy selected data onto the clipboard.    This command is unavailable if there is no 
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts
Toolbar:
Keys: CTRL+C



Paste command (Edit menu)
Use this command to insert a copy of the clipboard contents at the insertion point.    This command is 
unavailable if the clipboard is empty.

Shortcuts
Toolbar:
Keys: CTRL+V



Toolbar command (View menu)
Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in APRCalc, such as File Open.    A check mark appears next to the menu item when the 
Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in APRCalc,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To
Open a new scenario.

Open an existing scenario.    APRCalc displays the Open dialog box, in which you can locate 
and open the desired file.

Save the active scenario or template with its current name.    If you have not named the 
scenario, APRCalc displays the Save As dialog box.

Print Preview the active scenario.

Print the active scenario.

Export the active scenario to an ASCII text file.

Exit the APRCalc application.

Remove selected data from the scenario and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Align the active child window to the top-left corner of the frame.



Status Bar command (View menu)
Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the APRCalc window.    To display or hide the status bar, use 
the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Always On Top command (View menu)
Use this command to force the APRCalc application to always be on top of all other windows.



Discount Points command (Tools menu)
Use this command to calculate the discount points breakeven date. This module is used when you are 
working with a mortgage loan on a house.    For simplicity, I will describe its use assuming that you are the
buyer.

"Discount points", which can be thought of as prepaid interest, is money (expressed in percentage points)
the buyer (or seller) pays at the time of sale in order to get a lower interest rate.    For example, on a 
$100,000 mortgage, 2 discount points would be $2000, and might lower your interest rate from 8 to 7 
percent (I just pulled these numbers out of a hat).    The idea is that by paying a little interest now, you can
reduce the amount of interest you would pay over the life of the loan.    Another way to put it is that you 
are betting that you will stay in the house long enough to recoup the money you paid in discount points by
making smaller monthly payments.

This means it will take a certain amount of time before you breakeven.    There are several rules of thumb 
about this, but this module figures out that breakeven date exactly.      Select "Tools, Discount Points..." 
from the menu, and the following dialog box will appear:

Enter the number of points (for example, 2) and the new, discounted rate (for example, 7).    Notice that 
the program calculates the actual dollar amount of the discount points, and the rate difference, as you 
enter the values.    Now click on the "Calculate" button to determine the Breakeven Date.    This discount 
points scenario is only a good deal for you if you keep the house until the displayed Breakeven Date or 
beyond; otherwise you will lose money on the deal.

The values you enter in the Discount Points dialog box will be saved along with the rest of the loan 
scenario in its APR file.

Related Topics:

Saving a File



Cascade command (Window menu)
Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)
Use this command to arrange multiple opened windows in a non-overlapped fashion.



Window Arrange Icons Command
Use this command to arrange the icons for minimized windows at the bottom of the main window.    If 
there is an open scenario window at the bottom of the main window, then some or all of the icons may not
be visible because they will be underneath this scenario window.



Window Close All Command
Use this command to close all open child windows.    For each window, you will be prompted to save the 
associated scenario if necessary.



Window Align to Corner Command
Use this command to align the active child window with the top-left corner of the MDI frame window.    This
command is useful after you have opened several child windows, and Windows tries to cascade them for 
you.    Note that APRCalc will always align a child window if it is the only window currently open - this is 
not standard Windows behavior, but is a useful feature anyway.



1, 2, ... command (Window menu)
APRCalc displays a list of currently open scenario windows at the bottom of the Window menu.    A check 
mark appears in front of the scenario name of the active window.    Choose a scenario from this list to 
make its window active.



Index command (Help menu)
Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using APRCalc and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Search for Help On... command (Help menu)
Use this command to display the "Search..." dialog box within APRCalc Help.



Using Help command (Help menu)
Use this command for instructions about using Help.



About command (Help menu)
Use this command to display the copyright notice and version number of your copy of APRCalc.



Context Help command 

Use the Context Help command to obtain help on some portion of APRCalc.    When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the APRCalc window, such as another Toolbar button.    The Help topic will be shown for 
the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and scenario.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the scenario
Restore button



Scroll bars
Displayed at the right of the amortization window.    The scroll boxes inside the scroll bars indicate your 
vertical location in the amortization.    You can use the mouse to scroll to other parts of the scenario.

The scrollbar is used in APRCalc's amortization window to display different payments in the amortization.



Size command (System menu)
Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)
Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)
Use this command to reduce the APRCalc window to an icon.

Shortcut
Mouse: Click the minimize icon    on the title bar.
Keys: ALT+F9



Next Window command (scenario Control menu)
Use this command to switch to the next open scenario window.    APRCalc determines which window is 
next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (scenario Control menu)
Use this command to switch to the previous open scenario window.    APRCalc determines which window 
is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)
Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single scenario, the Close command on the scenario 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a scenario window

ALT+F4 closes the APRCalc child window



Restore command (Control menu)
Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)
Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Modifying the Loan Scenario
There are several ways to modify the information the loan scenario.    Please refer to the Related Topics 
below.

Related Topics:

Enter Values
Setup Rates for ARM
Choose the Payment Period
Calculate the Desired Value
Amortize Payments
Display Annual Subtotals
Find Subtotals for Selected Payments
Select Payments
Enter Prepayments to Principal
Find Prepayments for Proposed Term
Clear All Prepayments
Add A Note



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Implementation Notes
APRCalc uses the APR Payment Equation to make its calculations.    Values that can be explicitly 
formulated, such as payment and amount financed, are calculated in one step.    The rate and term, 
however, must be calculated iteratively as there is no closed form for them; the bisection method was 
chosen for its ease of implementation.    Since the equations involved are monotonic around the values 
typically dealt with in loans, the bisection method is guaranteed to (eventually) converge to an answer.

APRCalc was written in C++ using Microsoft's Visual C++ version 1.52, the Microsoft Foundation Classes 
(MFC) version 2.5, and the Microsoft Help Compiler, version 3.10.505, on a Pentium 90 system.    The 
code uses the large memory model, employs the MFC250, MUSCROLL, and CTL3DV2 DLLs, and is 
made up of thirty-six source code modules.



The APR Payment Equation
The APR Payment Equation is:

        Amount * (Rate ^ Term) * (Rate - 1)
Payment      = ----------------------------------------------------------

                                  (Rate ^ Term) - 1

where "Rate" is equal to one plus the periodic APR rate; for example, given monthly payments and an 
APR of 10%, "Rate" is 1.008333333 - that is, 1 + (0.10/12).



Comparisons to Actual Payments
The values displayed by APRCalc may not exactly match those that a lender would provide.    There are 
several possible reasons for this (in order of likelihood):

1. APR rates can be lowered slightly due to the presence of "Odd Days 
Interest."    Briefly, if the first payment is more than 30 days from the 
current date (45 days is common with automobile loans), this will 
effectively lengthen the loan, which of course increases the amount of 
interest that must be paid.    The rate is usually increased slightly to 
account for this, as it is the only changeable variable.

2. The loan being compared to may not be an APR loan.    Lenders often 
use terms like "simple interest" and "APR" as if they were 
interchangeable, when they are in fact different.    Also, a few lenders 
calculate interest in a proprietary way (but this is rare).

3. APR calculations are based on the assumption that all periods are 
equally long.    Calculations that use a 365-day year will not agree with 
APRCalc.

4. Some institutions round payments to the next penny, while others do not. 
APRCalc rounds payments to the next penny.

5. The lender's calculations may be in error.    Occasionally lenders' 
computers are not programmed correctly and compute incorrect 
payments.    This is rare but it does happen, especially when loans are 
sold from one lender to another.

6. APRCalc may be in error due to rounding and error accumulation.    
Especially in iterative calculations, errors in seemingly insignificant digits 
can mount quickly.    While care has been taken not to mix very large and
very small operands, and all calculations are done using long double 
variables, no serious effort at sophisticated error analysis has been made
with APRCalc (and it seems to give correct answers anyway).

7. There are no known bugs in APRCalc, but the possibility should not be 
overlooked.

Some apparent errors are not in fact errors, but are due to the non-continuous nature of converting real 
numbers to dollars and cents.    For example, given a payment of $1500, a rate of 10%, and a term of 36 
months, the exact amount financed is $46,486.8533779875.    However, most lenders round this to the 
next cent (that is, $46,486.86).    In actuality, any amount financed between $46,486.70 and $46,487.00 
will generate a (rounded) payment of $1500.00 for this scenario.    (These penny-fractions can up over the
life of a mortgage loan however, so the last payment is used to reconcile the numbers exactly.)



Planned Enhancements
If you have any ideas for improvements to APRCalc, please contact Larry Leonard through CompuServe 
71753,2426 (or, from the Internet and other networks, at 71753.2426@compuserve.com).

Please note this will be the last 16-bit revision of APRCalc, that is, for the 
Windows 3.1 environment.    The next revison will be APRCalc 3.0, and will be a 
32-bit application for Windows 95.

The following enhancements may be included in future revisions of APRCalc:

Print a Reg-Z disclosure box on-screen and to the printer.

Allow for odd days interest.

Use tabbed dialog boxes to present data more efficiently.

Include an "effective payment" module to show the payment each 
month allowing for the federal income tax deduction for mortgage 
interest, and for inflation.

Add a module to handle mortgage loan "buydowns".

Create a module to qualify buyers for mortgages.

Provide support for Canadian payments.

Show prepayment savings for variable rate mortgages.

Support variable interest rate mortgages, where there is a different 
rate for each payment.

When calculating the discount points breakeven date, optionally 
allow for inflation's effect.

Create a way to display the prepayments required to save a 
specified amount of interest.

Support balloon notes.

Provide a drop-down calculator for all numeric entry fields.

Related Topics:

Registering APRCalc



Revision History
For changes in the current revision, please see the New Features topic.

Revision 1.0 - Beta: October, 1993

1. This first revision was created for submission to the Association of Shareware 
Professionals (ASP).    It was rejected as being a trivial application.

Revision 1.1: February, 1994

1. A compiler switch setting error that prevented the program from running on systems 
without a math coprocessor was corrected.    This fix also corrected an error in 
calculation on such systems.

2. Support for BiWeekly payments was added.

3. The amortization calculations are now begun as soon as a "Calculate" button is 
clicked, and continue after the "Amortize" button is clicked, until the end of the 
schedule is reached.    Since the display begins immediately, this results in 
apparently almost instantaneous amortizations.    Also, the amortization calculations 
now run in the background, allowing other running applications to share the CPU.    
Also, the calculations were expressed differently and now run 33% faster.

4. The way the amortization window is scrolled was enhanced.    Scrolling to the end no
longer leaves one line only on the screen, and if the amortization will fit entirely in 
the window as it is currently sized, the scrollbars go away.

5. The "Alt-A" keystroke now clicks the "Amortize" button, as it should.

6. A bug in the way the "Setting..." dialog box restored values if you clicked the 
"Cancel" button has been corrected.    Also, the "round to nearest" check boxes 
default to TRUE now.

7. Previously, if you clicked the "Cancel" button while printing an amortization, all 
subsequent amortizations would abort while printing also.    This has been fixed.    
Also, the percent completed now displays.    The loan variables, and the filename, 
now print on the hardcopy.

8. If you attempt to exit Windows and have APRCalc running, and the "Save Settings" 
menu item is not checked, you are warned that you will lose your values, and are 
given a chance to save them, dump them, or abort your exit of Windows.

9. Previously, if you entered a bad value for a variable (for example, -123 months), the 
"Amortize" button was enabled anyway (when it should have been disabled).    This 
has been fixed.

10. You can now run multiple instances of APRCalc on your screen; for example, you 
may want to do side by side comparisons of a loan at two different rates.    (The 
program was changed from the compact memory model to the medium.)



11. The source code has been broken into several modules, which minimizes the 
memory requirement at any moment, and allows the program to load much more 
quickly.

12. All beeps used in the program now use the system-wide settings selected in the 
Windows Control Panel.

13. The amortization widow is no longer modal, that is, you can change loan variables 
with the amortization widow open, and watch the amortization change.    Also, if the 
"Options, Watch Calculations" menu item is selected, amortization calculations are 
now shown in the area used to display loan calculations.

14. The profile file now contains a Revision stamp; the first time the program is run and 
detects the APRCALC.INI file is from a previous revision, it displays a greeting, 
erases the APRCALC.INI file, and rewrites it using the new revision format.    Also, 
the program prompts you to associate the APRCalc program with the .APR 
extension (unless it is already associated).

15. The scrollbars used in the previous revision were replaced with subclassed 
spinbuttons.

16. Various internal housekeeping patches were made.

17. A third-party installation program is used on the disk version (as opposed to the 
bulletin board version) of APRCalc.

Revision 1.2: June, 1994

1. Bitmaps in the help file now display a little more quickly.

2. Only non-dithered colors may now be selected as the background color for loan 
scenarios.    This is due to a bug in Windows in the way control background colors 
are displayed.

3. Previously, if the amortization window was open, and you opened a new APR file, 
the old amortization schedule would remain on the screen.    This has been fixed.

4. The maximum term has been decreased slightly to 788 (enough for 30 years of 
BiWeekly payments, so this should not be much of a problem).

5. You can now enter the first payment date for a loan, and the amortization will show 
the date of each payment.

6. A note can be added to each loan scenario so that you can remind yourself details 
about the file.    The note can be up to about 32,000 characters. 

7. Several dialog boxes have been fixed so that the <Return>/<Enter> key will move 
between fields.

8. A module to calculate the breakeven date for discount points was added.

9. My crappy-looking spinbuttons were replaced with neat looking microscrolls.



Revision 1.3: February, 1995

1. The amortization window (and the button that opens it) was removed and replaced 
with a listbox.

2. The amortization printout can now include a line of text at the beginning.

3. The application was largely rewritten for stability, code size, memory overhead, and 
speed.

4. The first payment date now has a default value of 1/1/96.

5. The date of each payment in the amortization window now takes the payment 
period into account.    Previously the payment dates were always a month apart, 
regardless of the period of the payments.

6. Three-D effects were added using Microsoft's CTL3D library.    (This required that 
the ability to choose the application's background color had to be removed.)

7. An optional StatusBar and ButtonBar were added.

8. A bug in the "File, Save As..." menu selection was corrected.    Previously the 
filename did not always append the "APR" extension.

9. The maximum number of payments has been increased to 2080 (40 years of 
weekly payments).    Also, the amount of memory needed has been reduced.

Revision 1.4: March, 1995

1. A "General Protection Fault" that could occur if a scenario was re-calculated with a 
larger term has been corrected (this bug was introduced at Rev. 1.3).

2. Several changes were made to the design of the program to make it fit in a VGA 
(640 x 480) display.

3. Printing or exporting the amortization before the Scenario is fully amortized no 
longer locks the system.

4. When a new scenario is created, the Note from the previous Scenario is no longer 
incorrectly retained.

5. A prepayment of principle amount can be entered for any number of payments.

6. The amortization calculations were simplified, and the way background 
amortization processing is done was streamlined.

7. The hardcopy of the amortization schedule now prints out the loan variables and 
the filename of the Scenario.

8. Payments are now rounded up to the next penny, in keeping with the way most 
mortgages are calculated.



9. Saving a loan Scenario no longer incorrectly removes the contents of the 
amortization window.

10. Problems with the "File, Open...", "File, Save As...", and "File, Export..." dialog 
boxes were corrected.

11. When exporting the amortization to a text file, the "Cancel" button now works 
correctly.

12. Keyboard accelerators were added to the program.

13. The amortization window is drawn with much less flicker at the beginning.

14. New buttons have been added to the buttonbar.

15. Zero values in the loan variables comboboxes are now displayed as empty rather 
than "$0.00".

16. The buttonbar is now created with much less annoying flicker when the application 
is first started.    Also, if APRCalc is restored after being minimized to an icon, the 
buttonbar now displays correctly.

17. Various cosmetic changes were made to several dialog boxes to improve their 
appearance.

18. Notes for Scenarios can now be up to 2047 characters long.    Also, carriage return 
characters no longer truncate the note - they are now converted to spaces.

Revision 2.0: August, 1995

1. APRCalc is now a Multiple Document Interface (MDI) application, which allows you
to have several loan scenarios open at once.    Previously, only one scenario could 
be open at once.

2. Adjustable Rate Mortgages (ARMs) are now supported.

3. APRCalc can now find the prepayments required to shorten the term to a specified 
number of payments.

4. The amount of any prepayments are now displayed in the amortization window, 
rather than having those payments that have prepayments displayed in red.

5. The total amount of the prepayments, and the amount of interest they saved over 
the lifetime of the loan, are now shown.

6. Annual interest and principal subtotals can now (optionally) display in the 
amortization window (and print out on the hardcopy).

7. The "Prepaid" dialog box now shows interest and principal subtotals on either a To-
Date basis or a sum total basis (this feature replaces previous revision's total 
interest and total principal columns in the amortization window).

8. Amortization hardcopies are now professional-looking quality, and now optionally 
prints the Notes that you previously attached to the scenario.    Also, custom titles 



now optionally can be printed.

9. The amortization window now has "T" and "B" buttons above and below the 
scrollbar (to scroll immediately to the "top" or the "bottom".)

10. A "?" button now replaces the menu selection previous used to select term type.

11. Calculations now continue to limit of your PC's accuracy, not to any arbitrary 
tolerance.

12. Floating point numbers and money now respond to Windows Control Panel 
settings (in the International applet).

13. The "Selected" button can now select payments in the amortization window that 
have prepayments.

14. All dialog boxes are now centered in the application.

15. Support for yearly (or, annual) payments has been added.

16. The application now supports "Print Preview", whereby you can see what printouts 
will look like before you print it out.

17. Context-sensitive help has been added (via "Help" buttons) to most dialog boxes.    
Also, "Shift+F1" support has been added; there is also an icon on the toolbar that 
supports it.

18. APRCalc was completely rewritten from scratch in C++, and now computes 
amortizations 61% faster than the previous revision!

19. Changing the Note attached to the loan scenario no longer incorrectly erases the 
contents of the amortization window.

20. Saving the loan scenario no longer incorrectly disables the "Selected" button.

21. If the final payment had a prepayment, APRCalc previously decreased the principal
part of that payment instead of the prepayment; this has been corrected.

22. When selecting payments in the Select Payments dialog box, clicking an edit 
control now automatically selects the corresponding radio button.

Revision 2.1: November, 1995

1. A drop-down date control was added to the First Payment Date control, making it 
easier to enter a valid date.

2. Scenario files can now be optionally password protected for improved security.    
The password is stored in an encrypted form.

3. A clock has been added to the statusbar - its format is controlled by the settings in 
the International applet of the Control Panel.

4. A progress bar has been added to the status bar, to make it easier to visually track 
the progress of amortizations and exports.



5. Registration id text (for registered users only) now appears in the About dialog box, 
and on hardcopies.

6. A File, Save All menu item has been added to make it easy to quickly save all open 
scenarios.

7. A File, Delete... menu item has been added, enabling users to easily delete APR 
files that are no longer needed.

8. The "?" button next to the Term button now has a more attractive appearance, and 
now displays a dialog box that allows you to quickly select a term type.

9. The Annual Totals checkbox is now disabled if the scenario is using Annual 
payments, rather than print a useless subtotal on every other line.

10. Dates that are probably meant to be 21st century - such as "10/2/22" - now expand 
to 21st century instead of the 20th.

11. Amortizations are now timed to 1/100 of a second, so that you can easily see how 
much faster APRCalc is than its competition.

12. Calculations now check first that the existing value is not already a solution.    This 
prevents the value drift problem of previous revisions.

13. The average payment on ARMs (Adjustable Rate Mortgages) now appears at the 
end of the amortization window, as well as on printouts.

14. This help file now has a clearer user interface, a better title page, better use of color,
and additional pushbuttons on the toolbar.

15. Saving and opening scenarios to disk is now much faster than before, and scenario 
files (*.APR) are now up to 90% smaller, taking up much less disk space!

16. The executable file (APRCALC.EXE) is now 30% smaller than at the previous 
revision!

17. Some debugging code was rewritten so that it would remove itself totally in the 
release version, making APRCalc even faster!

18. Entering a date whose day was after 28, such as 1/31/95, caused all payments 
dates to use that day, even if that month did not have that many days, such as 
2/31/95.    This has been corrected.

19. Scenarios with certain specific terms (for example, 49 payments) would not display 
the last page correctly in File, Print Preview... (although the actual printouts were 
correct).    This bug was introduced at Rev. 2.0 and has been fixed.

20. Attempting to use File, Open... to read a non-APRCalc file could, in certain rare 
situations, cause APRCalc to crash.

21. Entering certain illegal dates as the First Payment Date could cause APRCalc to 
crash.

22. For ARMs, or scenarios with prepayments, the Payment value for the last payment 
was reported incorrectly (although the Last Payment: value at the bottom of the 



amortization widow was shown correctly).    This bug was introduced at Rev. 2.0 and
has been fixed.

23. Two embarrassing misspellings were corrected.



What You Get By Registering
By registering APRCalc, you will receive the following:

Three months of technical support (via mail, either Post Office or CompuServe)!

Your name (or whatever you tell me to put there) in the Help, About... box, and on all hardcopy 
printouts! 

The latest version of APRCalc - even if you order an older version - with the Nag Screen 
removed.

Preferential treatment when you have an idea for an improvement to APRCalc. Registered users 
go to the front of the line when it comes to including their cool new features in the next Revision.

The satisfaction of having encouraged a starving artist (okay, maybe not starving...) to continue to
produce high-quality shareware applications. Look at it this way: if not for APRCalc, you would 
have to use one of its competitors (shudder!).

Related Topics:

Registering APRCalc



Registering APRCalc
APRCalc is not free software. It is Shareware, which means you are expected to pay to register the 
program if you continue to use it. To register your copy of APRCalc, GO SWREG in CompuServe, and 
register package #7280.

Or, please print the file ORDER.TXT, fill it out, and send it (along with a check for $15) to:

Larry Leonard
P.O. Box 2226
Norcross, GA    30091-2226

Please include any comments or ideas for improvements. Thanks.

Related Topics:

What You Get By Registering
Planned Enhancements



License Agreement and Warranty Disclaimer
Users of APRCalc must accept this disclaimer of warranty:

APRCalc is supplied "as is".    The author disclaims all warranties, expressed or implied, including, without
limitation, the warranties of merchantability and of fitness for any purpose.    The author assumes no 
liability for damages, direct or consequential, which may result from the use of APRCalc.

APRCalc is a "Shareware program" and is provided at no charge to the user for evaluation.    Feel free to 
share it with your friends, but please do not give it away altered or as part of another system.    The 
essence of "user-supported" software is to provide personal computer users with quality software without 
high prices, and yet to provide incentive for programmers to continue to develop new products.    If you 
find this program useful and find that you are using APRCalc, and continue to use APRCalc after a 
reasonable trial period, you must make a registration fee of $15 to Larry Leonard.    The $15 registration 
fee will license one copy for use on any one computer at any one time.    You must treat this software just 
like a book.    An example is that this software may be used by any number of people, and may be freely 
moved from one computer location to another, so long as there is no possibility of it being used at one 
location while it is being used at another, just as a book cannot be used by two different persons at the 
same time.

Commercial users of APRCalc must register and pay for their copies of APRCalc within 30 days of first 
use, or their license is withdrawn.    Site-license arrangements may be made by contacting Larry Leonard.

Anyone distributing APRCalc for any kind of remuneration must first contact Larry Leonard for 
authorization.    This authorization will be automatically granted to distributors recognized by the ASP as 
adhering to its guidelines for Shareware distributors, and such distributors may begin offering APRCalc 
immediately.    (However, Larry Leonard must still be advised, so that the distributor can be kept up-to-
date with the latest version of APRCalc.)

You are encouraged to pass a copy of APRCalc along to your friends for evaluation.    Please encourage 
them to register their copy if they find that they can use it.    All registered users will receive a copy of the 
latest version of APRCalc.

Related Topics:

Planned Enhancements
Registering APRCalc



Definition of Shareware
Shareware distribution gives users a chance to try software before buying it.    If you try a Shareware 
program and continue using it, you are expected to register.    Individual programs differ on details - some 
request registration while others require it, some specify a maximum trial period.    With registration, you 
get anything from the simple right to continue using the software to an updated program with printed 
manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder retrains all 
rights, with a few specific exceptions as stated below.    Shareware programmers are accomplished 
programmers, just like commercial authors, and the programs are of comparable quality.    (In both cases, 
there are good programs and bad ones!)    The main difference is in the method of distribution.    The 
author specifically grants the right to copy and distribute the software, either to all and sundry or to a 
specific group.    For example, some authors require written permission before a commercial disk vendor 
may copy their Shareware.

Shareware is a distribution method, not a type of software.    You should find software that suits your 
needs and pocketbook, whether it is commercial or Shareware.    The Shareware system makes fitting 
your needs easier, because you can try before you buy.    And because the overhead is low, prices are low
also.    Shareware has the ultimate money-back guarantee - if you dont use the product, you don't pay for 
it.





APRCalc 2.2 - a Microsoft Windows 3.1 loan amortization program.    Copyright 1993-96    by Larry 
Leonard.



The "Payment" is the periodic installment amount of the loan.



The "Amount Financed" is the dollar amount to be borrowed, and against which interest is applied.



The "Term" is the number of periods (for example, months or weeks) that the loan is paid back over.



The "Rate" is the Annual Percentage Rate (APR) that the borrower will pay for the loan.



The "Principal" is that portion of the original Amount Financed that has not yet been paid.



The "Interest" is that portion of the total interest charge for the loan that has not yet been paid.



"Young Doorknob Owners" are people who have made so few payments on their home mortgage loan 
that they have equity only in the doorknobs.



The "Payment Number" refers to the number of payments that have been made.    When the loan is 
completely repaid, the Payment Number is the same as the Term; likewise, before any payment have 
been made, the Payment Number is zero.



A "Profile" is a file that is used by an application to store information (usually settings) from one run to the 
next.



The APR Payment Equation calculates the equal installments for a loan based on the amount financed, 
the term, and the rate of the loan.



Iteration refers to a process that is done repeatedly until a desired result is achieved.



The bisection method is a procedure to calculate a "root" of an equation (that is, where the equation is 
equal to zero) by repeatedly guessing values for the variable in question, seeing if the value yielded was 
too high or too low, and making the next guess accordingly.    Each guess is exactly halfway between the 
most recent guess known to be too low and the one known to be too high.



A function is monotonic over a given range if it does not both increase and decrease in value as the value 
of its dependent variable increases over that range.



"Windows" and "Visual C++" are registered trademarks of Microsoft Corporation.



Pentium is a registered trademark of the Intel Corp.



A "long double" is a variable which (in this implementation) uses 80 bits to represent a real number.    
Using long doubles allows for both larger and more accurate numbers to be calculated.



A "counting number" is any positive integer; it is the series "1, 2, 3, ...".




